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Product Overview 

 
Essential FTIR is a program that provides a potent environment for the acquisition, 
manipulation and presentation of infrared data.  Infrared data, whether in the form of 
interferograms, raw energy spectra, transmission spectra or absorbance spectra, may be 
represented as arrays consisting of an x vector (e.g. frequency) and a y vector (e.g. 
absorbance).  Essential FTIR can be used to manipulate, process and analyze these vectors.  
Though a large number of tools and options for the manipulation of such data are available, 
Essential FTIR achieves simplicity by relying on a small number of organizing principles. 
 
While this manual is intended as a reference for Essential FTIR, it will also focus on a 
tutorial based approach, offering new users a chance to familiarize themselves with the many 
tools and functions offered by the program.  Taking each topic in a logical sequence, from 
opening and saving data, through manipulating, editing and transforming spectra, to 
presenting graphics, this manual aims to provide a complete guide to the functionality of this 
scientific software.  Some familiarity with FTIR operation and data handling will be assumed, 
as it is beyond the scope of this manual to provide a ôfirst principlesõ explanation of all the 
concepts encountered when exploring FTIR data, though as much detail will be provided as 
possible throughout. 
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Installation 
 
Essential FTIR is installed via its setup file.  This may be obtained from the software CD, 
or from a download.  In either case the procedure for installing the software is the same.  In 
this example we will assume that the software was downloaded to a location on your hard 
disk.  Once the setup file is located, installation is initiated either by double clicking the 
appropriate icon, or by right-clicking the icon and selecting Open from the context menu. 

 

 
Figure 2.0 Essential FTIR setup icon 
 

Initializing the installation delivers the window illustrated in figure 2.1 

 



 7 

 
Figure 2.1 Setup introduction screen 
 

Clicking Next continues the installation.  The installation program will then display the 
license agreement, as shown in figure 2.2.  This should be accepted before clicking Next. 
 

  
Figure 2.2 License agreement 
 

Once the license agreement is accepted, the install button is displayed as shown in figure 
2.3. 
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Figure 2.3 Ready to install screen 
 

Once the install button is pressed the installation will proceed.  On concluding the 
installation the setup program will display the window shown in figure 2.4.   
 

 
Figure 2.4 Setup complete notification 

 
 
A check-box is displayed in this window, which allows running of Essential FTIR 
immediately upon clicking the Finish button, which concludes the installation.  If this box 
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remains unchecked you may choose to start the program either from the Programs menu, 
or by double clicking the shortcut icon.  These methods of starting Essential FTIR are 
shown in figures 2.5 and 2.6. 
 

 
Figure 2.5 Program Menu 

 
 

 
Figure 2.6 Desktop shortcut 
 
 

Essential FTIR is now installed and ready for use.  In the next chapter, weõll begin to 
explore the program. 
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Getting Started 
 

The Essential FTIR Main Window 

 
When starting the program you are presented with the Essential FTIR front end, which we 
will refer to as the Desktop.  This desktop is illustrated with its default settings in figure 3.0. 
 

 
Figure 3.0 Essential FTIR desktop 
 

At the highest level, the Workspace contains the data on which operations may be 
performed.  Multiple workspaces may be opened, though only a single workspace may be 
active at any one time.  A workspace may be viewed as a container which holds the data to 
be manipulated.  Many spectra may be displayed in a Workspace, but only one spectrum 
may be active at a time, and this active spectrum is displayed along with associated header 
information.  Toolboxes contain Tools which are used to perform operations on spectra.  
In order to edit or manipulate a spectrum, it is often necessary to define a Region upon 
which to perform operations.  A Region is defined in Essential FTIR by clicking and 
dragging over a portion of a spectrum in a manner familiar to Windows users.  Regions may 
be named, saved and stored for later use, further simplifying many complex operations.  
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Display Setup 
 
You have a choice with regard to the Essential FTIR  display.  The software is designed to 
run under Microsoft Windows.  Some users may feel that the features of the graphical user 
interface are best viewed under Windows òclassicó theme.  The Essential FTIR desktop 
viewed in this mode is shown in figure 3.1. 
 

 
Figure 3.1 The Essential FTIR desktop 
 

While Essential FTIR runs identically under the Windows XP theme and the Windows 
òclassicó theme, the interface appears superficially different.  This is most apparent when 
discussing the re-sizing of desktop elements.  When passing over boundaries between 
desktop elements, the cursor will assume the re-sizing arrows.  This change in cursor 
appearance is shown in figure 3.2. 
 

 
Figure 3.2 Resizing cursor 
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Once the cursor assumes the re-sizing arrow shape, left-clicking and dragging with the 
mouse will re-size the selected border of the desktop element.  Some users feel that the 
borders between elements are more easily recognized when using the Windows òclassicó 
theme.  The choice of themes is ultimately a matter of user preference, as switching themes 
is trivial ð right-clicking on the Windows desktop summons a context menu, shown in figure 
3.3. 
 

 
Figure 3.3 Windows desktop context menu 
 

Selecting òpropertiesó from this menu summons the dialog  box shown in figure 3.4. 
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Figure 3.4 Windows display properties dialog box 
 

On the òThemesó tab there is a drop-down menu from which you may choose from a 
selection of themes.  Clicking òOKó applies the selected theme.  This manual will be 
presented using the Windows XP theme. 
 

Workspaces 
 
The Workspace window may comprise a number of Workspaces, which are selected as 
active by tabs.  These tabs are shown in detail in figure 3.5. 
 

 
Figure 3.5 Workspace tabs 
 
By default, the initial active Workspace Window is occupied by the Help  interface.  We will 
discuss changing default settings in the Options section in chapter five ð The Essential 
FTIR  Menus, where instructions are presented which enable you to display a pre defined 
page on startup, or no page.  Clicking on a Workspace Selection Tab renders that 
workspace active.  The Workspace is a flexible environment where we may view spectra, 
and review any changes to our data that we make using the tools offered by the program.  
We will look now in detail at an active Workspace with some example data loaded. 
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Figure 3.6 The active Workspace 
 
Figure 3.6 shows an active Workspace, with three sulfur dioxide absorbance spectra 
displayed.  These spectra are supplied with Essential FTIR, and may be loaded by 
navigating to the directory containing them (the òSulfur Dioxideó folder in the default data 
directory) using the File Browser Tool.  On the left of the Workspace we see a browser 
panel.  Letõs resize this panel by dragging its boundaries as shown in figure 3.2 to view it in 
detail. 
 

 
Figure 3.7 Workspace browser panel 
 

The browser panel consists of four columns.  The first column is labeled V, and consists of a 
column of check-boxes ð one for each loaded data file.  The V is short for visible, and by 
default the visibility box is checked.  Clearing this check-box renders the associated spectrum 
invisible, though the data is not removed from the Workspace. 
 
The next column is labeled X, and also consists of a button for each data file.  Clicking on 
the button associated with a data file will clear that spectrum from the workspace. 
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The next column is labeled Filename, and contains the name of the data file.  The final 
column is labeled Memo, and contains any information held in the memo field of the data 
file.  
 
Right-clicking in this panel summons the context menu shown in figure 3.8. 
 

 
Figure 3.8 Brower panel context menu 
 
The menu may be used as a shortcut when selecting, removing or otherwise handling data in 
the window.  It is analogous to the Display Setup dialog discussed in chapter four. 
 
The Workspace display window is shown in figure 3.9. 
 

 
Figure 3.9 The Workspace display window 
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Graphic Display Controls 
 
The display consists of a Cartesian plot of the data files.  The y-axis is dependant upon the 
type of data currently active in the Workspace.  The x-axis may be labeled in wavenumbers, 
nanometers or microns ð or data points when viewing interferograms.  Changing the axes 
labels is discussed in the Display menu section of chapter four.  A collection of buttons and 
other items are clustered below the display window.  These items are known as the Graphic 
Display Controls, and are shown in more detail in figure 3.10. 
 

 
Figure 3.10 Graphic display controls 

 
These controls may be used to manipulate the data display.  Some of these features are 
replicated in the Display menu discussed in chapter four.  In the upper right of the control 
panel we see a drop down list.  This list contains all data files currently loaded in the active 
Workspace.  Selecting a data file from the drop down list will make that file the active 
sample in the Workspace.  In the upper left corner of the panel are two numbers.  These 
numbers represent the position of the cursor on the data display with reference to the 
Cartesian axes of the active data file.  The number on the left represents the position of the 
cursor on the x-axis, while the number on the right shows the location on the y-axis. 

 
 
All the remaining items are buttons.  These form four distinct sets: 
 

1. The File buttons 
2. The Display Limit  buttons 
3. The Axis Navigation buttons 
4. The Display Type buttons 

 
We will examine the function of each member of the four sets. 
 

File buttons 

 

  Designates the previous spectrum in the Workspace as active 

  Designates the next spectrum in the Workspace as active 

  Saves the active spectrum to disk 

  Undoes changes to the data 

  Allows you to change the color of the active spectrum (see Display menu in   
chapter four) 

  Copies the active spectrum to the internal clipboard.  This spectrum will then be 
available for pasting into another Workspace 
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  Pastes from the internal clipboard (not the Windows clipboard) 

  Creates a copy of the active spectrum in the current workspace - Cloning 
 

Display Limit buttons 

 

 Applies fixed scale limits to the data display.  The limits are specified using 
the Display menu system discussed in chapter four 

 Auto-scales the data display to include all points on all spectra in the window 

 Auto-scales the y-axis without changing the x-axis 

 Undoes the previous expansion ð you may choose from a list of previous 
expansions to undo from a drop-down menu, summoned by clicking the òdownó 
arrow on the Undo button 

 

 Force the units of the data in the display to be the same. Clicking on this button 
will display this menu: 

 
 This allows data with different X and or Y units to be displayed together. 

 Enables you to define the axis limits of the display by left-clicking and 
dragging a box around the desired area, known as òexpandó 

 Enables you to drag all visible spectra around the data display, known as 
òrolló 

 

Axis Navigation buttons 

 

 Moves all visible spectra to the left 

 Moves all visible spectra to the right 

 Moves all visible spectra down 

 Moves all visible spectra up 

 Zooms out on x-axis 

 Zooms in on x-axis 

 Zooms out on y-axis 
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 Zooms in on y-axis 
 

Display Type buttons 

 

 Toggles full screen display mode on and off 

 Displays data in Overlay mode ð all spectra retain their relative proportions 

 Displays data in Stacked mode ð all spectra are displayed in a separate 
display area, with the active spectrum lowest in the stack 

 Displays data in Superimpose mode, with spectral features matched on the 
y axis 

 Displays data in Paged mode ð only the active spectrum is displayed.  
Navigating through the spectra loaded into the Workspace will display each in turn 

 Displays the Print dialog box ð see chapter four, The File menu. 

  Displays the óExport Graphicsô menu. 

 Displays the menu shown in Figure 3.11, below. 

 Closes the workspace. 
 

 
Many of the functions provided by these buttons are also accessible via the menu system, 
described in chapter four of this manual. 
 
The last feature of the Workspace that we will note in this section is that of the Workspace 
tab context menu.  This menu is summoned by right-clicking on a Workspace tab, and is 
shown in figure 3.11. 
 

 
Figure 3.11 Workspace tab context menu 

 
This contains five items.  The New Workspace option creates a new Workspace, selectable 
by its tab.  The Rename option allows you to provide a meaningful name for a Workspace.  
The Close option exits the currently active Workspace.  The Close All option dismisses all 
open workspaces.  The Cancel option dismisses the context menu without further action.  
 
At the lower left of the Essential FTIR desktop we find the Toolbox Selection window, as 
shown in figure 3.12. This element of the desktop allows you to choose a set of Tools 
relevant to their needs. 
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Figure 3.12 Toolbox selection window 
 

The items on the toolbox selection window form a two stage hierarchy.  At the highest level, 
the toolboxes are represented as gray tabs.  Each of these tabs represents a collection of 
tools, grouped according to their function.  For example, the clicking the Data tab reveals 
tools that will handle files, acquire new data, convert between file types and other data 
handling functions.  Similarly, the other tabs contain tools relevant to their labels.  We will 
discuss the toolboxes in detail in chapter five ð  Toolboxes and Tools.. 
 
The final element of the desktop is the Tool Parameters Window, which is illustrated in 
figure 3.13.  This element is highly context sensitive ð when a tool is selected the appropriate 
parameters window is displayed for that tool.   
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k 
Figure 3.13 X-Shift parameters 
 

Many tools require user input, for example when making an adjustment to the x-axis vector 
of a spectrum using the X-Shift tool, it is necessary to define the amount of shift applied, 
and whether to òstretchó the spectrum or shift the whole axis. 
 
As an example of a typical operation often carried out in Essential FTIR, letõs look at how to 
locate, open and correct the baseline of an absorbance spectrum.  We may locate a spectrum 
using the File Browser tool contained in the Data toolbox.  If we assume that the desired 
spectrum is located in the folder òSulfur Dioxideó and has the filename òSO2_28ppmó, then 
we should click on the file to highlight it as shown in figure 3.14. 
 

 
Figure 3.14 Choosing a file for display 
 

Once the highlighted file is displayed in the lower right hand window, clicking the Add to 
Current Window button will load the spectrum into the workspace.  This result of this 
operation is shown in figure 3.15. 
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Figure 3.15 Adding a spectrum to a workspace 
 

Now that the spectrum is held in the workspace we are free to perform manipulations upon 
the data.  On inspecting the sulfur dioxide absorbance spectrum we notice that the y axis has 
a slope, with the high end at 4000cm-1.  Two tools are included in the Manipulations 
toolbox which may be used to correct this problem ð the Manual Baseline Correction and 
Auto Baseline Correction tools.  In this case we will use the Auto Baseline Correction 
tool, as shown in figure 3.16. 
 

 
Figure 3.16 Manipulations menu 

 
Clicking on the Manipulations tab of the toolbox selection window reveals the tools 
included in the Manipulations toolbox.  Highlighting the Auto Baseline Correction tool 
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on the menu reveals the tool parameters window for that function.  This window is shown 
in figure 3.17. 
 

 
Figure 3.17 Using auto baseline correction 
 

In this example the baseline of the sulfur dioxide spectrum varies between approximate 
absorbance values 0.05 at the high end and 0.00 at the low end.  Options available are 
òCorrection Orderó and òNormalizeó.  We have chosen òQuadraticó as the correction order 
so as to remove any curve present in the sloping baseline.  The òNormalizeó checkbox 
remains unchecked as increasing noise levels toward the lower extremes of the spectrum 
result in ònoise data pointsó well below zero, and normalizing to zero including these data 
points would result in lifting the entire spectrum so as to place the lowest point on the y axis 
at zero.   Clicking the Try button displays the projected result of the operation in gray in the 
workspace window.  Clicking the Apply to Current button performs the operation and 
replaces the visible spectrum with the corrected data.  This data is NOT saved automatically 
however, and closing the window or removing the data results in the spectrum being stored 
unsaved.  In order to save the corrected spectrum we must click the Save Asé button, 
which delivers the dialog box shown in figure 3.18. 
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Figure 3.18 Save Asé  dialog box 
 

After clicking the Save button on the dialog box shown in figure 3.17, the data is saved to 
the selected folder.  In the example above we have renamed the file with the prefix òNewó.  
If a different filename is not supplied the file will be over written. 
 
We have now covered all the basic elements of manipulating a spectrum in Essential FTIR : 
 

¶ Locating and opening a data file 

¶ Selecting an appropriate tool 

¶ Carrying out the operation 

¶ Saving the resultant file to disk 
 
One more concept must be explored before we go on to examine in detail the tools and 
features offered by Essential FTIR.   
 
 

Creating and Working with Spectral Regions 
 
The idea of Regions is central to the operation of the software.  A region may be defined as: 
òRegion ð A portion of the x -axis of a spectrum designated by the user to be 
operated upon, or designated by the user to be representative of that spectrum for the 
purposes of that operation.ó 
 
In Tools that work with Regions, Regions may be defined by right-clicking in the active 
Workspace window.  One right-click defines a Region Marker ð a vertical line delineating 
the edge of a Region.  This Region Marker may be repositioned by left-clicking and 
dragging, in a manner analogous the that previously described for re-sizing desktop 
elements.  Right-clicking in the Workspace window a second time completes the Region 
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with a second marker, and the portion of the spectrum selected is shaded.  The result of this 
operation is shown in figure 3.19, using the Zap Tool as an example. 
 

 
Figure 3.19 Region markers   
 
The numerical values of the Region defined in this way are recorded in a Region Table, as 
shown in figure 3.20. 
 

 
Figure 3.20 Region Table 

 
Part of the power of the Regions concept is that regions defined as described earlier may be 
saved to disk as a Regions file.  This may be achieved by right-clicking on the region table 
and selecting Save Table from the resulting context menu or by clicking the 
ôWavenumber...ô column headers of the region table.  The context menu is shown in figure 
3.21. 
 

 
Figure 3.21 Region table context menu   
 
These Regions may then be loaded as needed, for example as part of an automated batch 
processing routine ð easily configured in Essential FTIR with no requirement for 
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programming.  This process is described in chapter five in the section on the Batch 
Processor Tool. 
 
When defining a Region from which includes an endpoint of the data, it is not necessary to 
painstakingly position the cursor on the final data point.  If you select a point outside of the 
data range Essential FTIR will use the final point of the data. 
 
The above summary gave us a general overview of operations in Essential FTIR.  Many 
operations may be carried out in series, before the final result is saved.  In following chapters 
we will examine each feature of Essential FTIR in detail.  
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The Essential FTIR Menus 
 
 
In common with most programs running under Microsoft Windows, Essential FTIR uses a 
combination of menus and buttons to provide the mechanics of the user interface.  
Essential FTIR employs some redundancy in this regard ð some options and functions are 
accessible via either the menus or buttons, allowing you to access features in a manner 
comfortable and intuitive to the individual.  In this section we will examine the features 
unique to the menu system ð features accessible via the button interface will be detailed in 
the chapter relevant to that button. 
 
The Essential FTIR menus are shown in figure 4.0. 
 

 
Figure 4.0 The EFTIR menu 

 
The menu concept is familiar to most computer users.  The Essential FTIR menu is 
located at the top left of the desktop, and comprises five headings, each containing sub-
elements relevant to that heading.  We will examine each heading and sub-element in turn.  
It is worth noting that each menu sub-element has a corresponding keyboard shortcut, 
which is activated by pressing ctrl x, or alt x, where ctrl or alt is the òcontroló or 
òalternativeó key, and x represents the corresponding shortcut key.  The actual shortcut keys 
are listed on the menus to the right of the sub-element, where available.  For example, 
pressing ctrl O will deliver the Open File dialog box. 
 

The File Menu 
 
Clicking on the File heading displays the menu shown in figure 4.1. 
 

 
Figure 4.1 File menu 

 
Clicking Open on the file menu displays the dialog box shown in figure 4.2. 
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Figure 4.2 Open file dialog box 

 
The Open dialog box consists of a drop down menu which allows you to specify a drive, a 
browser window, a filename edit box, a file format drop down menu, an Open button and a 
Cancel button.  The C:/ drive is set as default.  On the upper right hand side of the window 
contains the folder viewing option buttons, which are shown in figure 4.3.  These buttons 
are common to most file handling dialog boxes in Microsoft Windows.  Examining the 
options from left to right we have: 
 

¶ Back button 

¶ Up one level button 

¶ New folder button 

¶ List view 

¶ Detail view 
 

 
Figure 4.3 Folder viewing options 

 
Folders visible in the browser window may be double clicked to show the contents.  Once 
the desired file is located, clicking the Open button loads the file into the active workspace.  
Clicking Cancel dismisses the dialog box without further effects. 
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Clicking New Workspace opens a new workspace window.  These windows are tabbed and 
may be renamed for clarity by right-clicking the workspace tab and using the context menu.  
Essential FTIR context menus are examined in Chapter six ð Context Menus.  By default 
multiple workspaces are numbered sequentially. 
 
Clicking Close dismisses the active workspace. 
 
Clicking Close All dismisses all visible workspaces. 
 
Clicking Save summons the Save dialog box, which is identical to the Open dialog box in 
figure 4.2, with the Save button replacing the Open button.  Once the desired location is 
displayed in the browser window, clicking Save results in the active file in the workspace 
being saved to that location. 
 
The Print button may be used to print the contents of the active workspace window.  
Clicking the Print button displays the dialog box shown in figure 4.4. 
 

 
Figure 4.4 Printé dialog box 
 

The printers installed on the computer are listed in the window at the top of the dialog box.  
An option of printing to a file is offered via a check box.  The Preferences button allows 
you to define the printing parameters, depending upon the printer selected, while the Find 
Printer button allows searching of network printers.  The page range is redundant in this 
printing application, as only the active workspace is printed.  The option to print multiple 
copies is given on the lower right hand side of the dialog box.  Clicking Print results in the 
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contents of the active workspace window being printed, while clicking Cancel dismisses the 
dialog box without further action. 
 
Clicking Exit  closes Essential FTIR. 

 
 

The Display Menu 
 
Clicking on the Display heading yields the menu shown in figure 4.5. 
 

  
Figure 4.5 The Display menu 
 

Clicking Setup results in the Display Settings parameter box being shown in the Tool 
Parameters Window, as illustrated in figure 4.6.  This parameter box is also accessible from 
both the Data Toolbox  and the Options menu. 
 

 
Figure 4.6 Display Settings 
 



 30 

The Display Settings parameters are split into tabs, shown across the top of the window.  
In figure 4.6 the first tab, labeled Display is highlighted.  Taking each of the tabs in turn: 
 

Display 
Provides fundamental options for the spectrum display.  The Data Area Color button 
allows you to choose the color of the backdrop to the spectra.  Clicking the Data Area 
Color button displays the Select color dialog box shown in figure 4.7.  This dialog box is 
common to all functions in Essential FTIR which allow color specification. 

 
Figure 4.7 Select Color dialog box 
 

The Select Color dialog box comprises a number of elements. A pre-defined selection of 
colors are displayed on the top left hand side of the dialog, while you may specify an 
intermediate shade using the custom color picker on the right hand side.  These may then be 
added to the Custom Colors palette on the lower left of the dialog by clicking the Add to 
Custom Colors button.  
 
The Background Color button summons a dialog box to that shown in figure 4.7, and 
allows you to set the frame color for the workspace window.  An example of the use of these 
two options together is shown in figure 4.8, where both the data area and the frame have 
custom colors defined. 
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Figure 4.8 Data area and background color changes 
 

The Grid check-box imposes a grid onto the data area, which may be toggled on and off.  
The Grid Color button summons the Select Color dialog box shown in figure 4.7.  The 
Grid Line Style drop down menu offers a number of choices for the type of grid-lines. The 
options are Solid, Dash, Dot, Dash-Dot and Dash-Dot-Dot. 
 
The Region Highlighting  check-box specifies whether regions currently selected for the 
Tools in use for the displayed spectrum are shown on the data area.  Regions are discussed 
in detail in chapter five ð Toolboxes and Tools.  The Highlight Color button summons the 
dialog box shown in figure 4.7, and is used to set the color used to shade the region.  Hence 
the workspace shown in figure 4.8, with dotted yellow gridlines, and a region defined in the 
Zap tool may be configured ð this is illustrated in figure 4.8. 
 

 
Figure 4.8 Altered display configuration 
 
 

The òDefault Display Modeó allows you to chose which display mode will be in effect for 
new data workspaces. 
 

Color Table 
 

Colors used to display spectra are chosen sequentially from this table: 
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In this example, we have chosen that the color table consist of 16 colors, and then 

selected the colors individually for each. So the first spectrum displayed will be green, 

the second will be blue, and so on.  After 8 spectra are displayed, óData Color 1ô will be 

used again. 

 

The óSearch Hit Colorô allows you display the library search hits in a unique color. 

 

 

Data Colors 
 
Allows you to set colors for each data file visible in the workspace, via the Select Color 
dialog box.  Each data file has a corresponding color button, as shown in figure 4.9. 
 

 
Figure 4.9 Data colors tab 
 

Hide/Remove 
 
The Hide/Remove  tab is used to manipulate the visibility of data displayed in the 
workspace.  There are six options available in the Hide/Remove  tab, as detailed in figure 
4.10. 
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Figure 4.10 Hide/Remove tab 
 

The options are: 

¶ Make All Visible - Renders all data loaded into the active workspace visible. 

¶ Make Non Visible -  Hides all data in the active workspace. 

¶ Invert Selection -  Hides visible data and shows hidden data. 

¶ Remove Invisible -  Closes data files not visible in the active workspace. 

¶ Remove all Data -  Closes all data in the active workspace 

¶ Close all Workspaces ð Exits all workspaces on the desktop. 
 
These options are similar to those given when using the context menu for the data window 
file list, shown in figure 3.8. 
 

X-Axis Direction 
 
Enables you to choose ascending or descending values for the x-axis from left to right.  The 
X-Axis Direction tab is shown in figure 4.11. 
 

 
Figure 4.11 X-Axis Direction tab 
 

Depending on the format of the data in the workspace, three options may be selected from 
the drop down menus: 
 

¶ Wavenumbers 

¶ Microns (and nanometers 

¶ Interferograms 
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The drop down menus for each file type offer a choice between ascending or descending left 
to right values. The default for infrared spectra is to display the x-axis such that energy 
(frequency) increases from left to right, which is why wavenumbers are displayed with high 
values on the left. 
 

X-Axis Fixed Limits 
 
Allows you to specify and apply fixed limits for the x-axis, as shown in figure 4.12. 
 

 
Figure 4.12 X-Axis Fixed Limits tab 
 
 

The edit boxes allow entry of desired axis limits for both microns and wavenumber scales, 
while the Click to Apply button applies those fixed limits to the data visible in the 
workspace. 
 

X-Axis Ticks 
 
Allows setting of tick markers on the x-axis, as shown in figure 4.13. 
 

 
Figure 4.13 X-Axis Ticks 
 
The Auto-Tick  check-box overrides the edit boxes below it.  The Click to Apply button 
implements the changes to the tick mark settings. 
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Y-Axis Fixed Limits 
 
Allows you to define fixed y-axis limits on the display, as shown in figure 4.14.  The x and y 
axis fixed limits settings define what happens when you click the fixed limits button on the 
data window tools.  Fixed limits allow data to be viewed in a consistent way, regardless of 
the actual limits of the data.   

 
Figure 4.14 Y-Axis Fixed Limits 
 

The tab consists of six edit boxes, which hold the fixed limit values for the low and high 
display values for absorbance, transmittance and single-beam data.  A Click to Apply button 
executes any changes made. 
 

Y-Axis Ticks 
 
Allows you to set y-axis tick marks in a manner analogous to the x-axis ticks tab detailed 
above.  The Y-Axis Ticks tab is shown in figure 4.15. 
 

 
Figure 4.15 Y-Axis Ticks 
 

As before, the Auto-Tick  check-box overrides any subsequent settings. 
 

Plot Labels 
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Figure 4.16 Plot Labels 
 

Five options exist in the Plot Labels options ð  
 

1. Automatic Labels: A check-box allows automatic labeling of axes, ignoring the 
settings below. 

2. X Axis Label:  Title for the X-axis 
3. Y Axis Label:  Title for the Y-axis 
4. Plot Title:  Title for the whole plot 
5. Plot Labels:  The Click to Apply button executes the plot labels for the 

active Workspace. 
 

Printing 
 
The Printing  tab enables print options for the workspace to be set, as shown in figure 4.17. 
 

 
Figure 4.17 Printing tab options 
 

The Black on White check-box may be checked to select black on white printing, with 
colors disregarded.  The drop down menu labeled Pen Width is used to select the weight of 
the lines representing the data.  The workspace may be sent to a printer using the Click to 
Print button. 
 
The subsequent options available on the Display menu are also accessible via two other 
methods ð the Setup menu item on the Options menu, and the Graphic Control buttons 
underneath the display area of the Workspace. 
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Reports 
 

 
 

The Reports tab controls how and where reports are saved to disk.  Some of the tools in 

Essential FTIR generate information that can be used to automatically create reports. 

These tools will have a button labeled óReportô on them.  The reports are generated in 

RTF format, which stands for óRich Text Formatô. This format can be read and written by 

Microsoft Word, but more importantly, it can be read and written by Write, also known 

as WordPad, which is installed with all windows systems. 

 

¶ Where to put reports: reports can be out into the Essential FTIR reports folder, or 

can be stored in the same folder as the datafile used to generate the report. 

¶ Report Storage Directory: If the reports are not stored in the same folder as the 

datafile, use this option to tell Essential FTIR where to put the reports. 

¶ How to Name Reports: The choices are óSample Basedô, in which case the .rtf 
file will have the same base filename as the FTIR sample datafile used to generate 

the report; óTime-Stampedô gives the reports a filename based on the time the 

report was generated, and óAsk the Userô will prompt the user for a filename. 

¶ Open Report in Word Processor: after the .rtf file is generated, it can 

automatically be displayed in a word processor. The word processor program that 

is used depends on your system configuration, eFTIR merely launches the 

program that Windows has associated with the .rtf file extension. 
 
 
 

Display Modes 
 
We now return to the discussion of the Display Menu.  After the Setup menu item, the 
next element of the Display menu is the Full Screen option.  Clicking this option toggles 
between docked and full screen display of the active workspace. 
 
The Autoscale menu item automatically sets the display limits of the workspace to 
encompass all points of the active spectrum. 
 
The Autoscale Y option expands the y-axis to encompass all data without altering the x-axis 
display settings. 
 
The Fixed Scale option sets the x and y axes to the limits specified in the X-Axis Fixed 
limits  and Y-Axis Fixed Limits on the Setup dialog ð see figures 4.12 and 4.14.    
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The final four options concern the way in which active data are displayed in the workspace.  
Selecting Overlay results in spectra being plotted on common x and y axes ð hence they are 
overlaid, as illustrated in figure 4.18 
 

 
Figure 4.18 Data in Overlay  display mode 
 

The Stacked option displays the data vertically stacked sets of coordinates, as shown in 
figure 4.19. 
 

 
Figure 4.19 Data in Stacked display mode. 
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Displaying the data in Superimpose mode matches the y axis magnitude of all active data.  
This feature is useful for comparing spectra collected at different path lengths or 
concentrations.  An example is shown in figure 4.20. 
 

 
Figure 4.20 Data in Superimpose display mode 
 

When viewing data in Superimpose mode, the y axis will automatically re-scale as the x axis 
limits are changed.  For example, in figure 4.21 the area between 1000cm-1 and 1300cm-1 is 
selected using the cursor in the display window.  Notice that the visible absorbance features 
are re-scaled so as to match each others magnitude as closely as possible. No tick-marks are 
placed on the y-axis because they would only apply to the active sample, and may be 
misinterpreted as they do not apply to the other spectra in the display. 
 

 
 
Figure 4.21 Superimposition with zoomed x-axis 
 

Selecting Paged mode displays only the active spectrum in the workspace window.  Any 
spectra loaded into the workspace may be selected as active, either by selecting the file in the 
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workspace browser to the left of the display window, or by selecting it from the list box on 
the display window or by cycling through the spectra in the workspace using the arrow 
buttons.  Paged mode is illustrated in figure 4.22. 
 

 
Figure 4.22 Selecting spectra for display in Paged mode 
 
 
 

The Change Display Units menu item has a submenu: 
 

 
 
These choices allow you to force conversion of all the data in a window to share the same 
units, when such a conversion is possible. This is useful when you have a mixture of 
absorbance and transmittance data, or a mixture of data calibrated in wavenumbers and 
wavelengths.  Using these menu choices will convert all of the data in the window so they 
can displayed on the same scale with the same units. 
 

The Options Menu 

 
The Options menu contains the interface for the Setup parameters.  Selecting Setup from 
the Options menu delivers the interface shown in figure 4.23. 
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Figure 4.23 Setup parameters 
 

The Setup parameters are displayed as a workspace tab.  On the left hand side of this Setup 
tab is a secondary menu.  This menu comprises options for the collection of data, data 
processing, instrument alignment, and data storage.  In addition, options concerning data 
display and printing are available.  These display options may also be accessed via the 
Display settings (see figure 4.5). 
 
The interface for the Setup menu is located in the main window of the Setup tab, on the 
right hand side.  This section of the tab is known as the Parameters Page.  The appearance 
of the particular page is dependant upon which option is currently selected as active.  An 
option is selected by left-clicking on that item in the menu.  Once the desired set of 
parameters is displayed, you may execute changes in those parameters using the drop down 
menus and edit boxes provided.  Each parameter is placed on a numbered row, and we will 
use these numbers to reference each parameter.  For instance, in figure 4.22 the Gain 
Multiple  parameter is listed on row 5. 
 
On each of the Parameter Pages, a series of options exist which are common to all pages.  
We will deal with these options first.  With the Collection option selected, as in figure 4.22, 
we see that rows 8 ð 13 are occupied by a series of buttons.  The functions of these buttons 
are: 
 

 
The Undo button rolls back all changes to parameters in the page since the last save. 
 

 
The Restore button rolls back all parameters in the page to factory default settings 
 

 
The Load button summons a dialog box used to locate and load a file containing pre-
defined settings for the parameters on that page.  The settings file is in .ini  format ð see 
Save. 
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The Save button enables you to save the parameters defined in that page to disk.  The 
parameters are saved in a .ini  file. 
 

 
The Lock button toggles a òsafeó mode on and off, where the parameters in that page are 
grayed out to prevent changes. 
 

 
The Help  button is used to display help topics relevant to the parameters page. 
 
As the above buttons are common to all parameter pages, we will not refer to them each 
time we encounter them, but concentrate on elements unique to each page.  Taking each 
page in turn from top to bottom we have: 
 

Collection 
 
The Collection parameters page is shown in figure 4.24. 
 

 
Figure 4.24 Collection parameters 

 
The parameters unique to the page begin on row 2. 
 

2. Resolution:  Sets the optical resolution for data collected from an instrument.  The 
resolution is changed via a drop down menu and may take values of 0.5cm-1 ð32cm-1. 

3. Scans:  Sets the number of scans to be co-added during the collection of a spectrum. 
4. Background Scans:  Sets the number of background scans to be co-added during 

the collection of a background spectrum. 
5. Gain Multiple:  Sets the gain for the data acquisition. 
6. Title Template:  Sets the information to be recorded into the spectrum file.  In the 

example given in figure 4.23 the number of scans, gain, resolution, date and time are 
entered in the template. 
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Process 
 
The Process parameters page is shown in figure 4.25.  These settings pertain to the Fast 
Fourier Transform (FFT), and control the processing of data from interferogram to a final 
data type of your choosing. 
 

 
 

 
 
Figure 4.25 Process and Advanced Process parameters 
 
Parameters unique to the page begin at row 2: 
 

2. Final Data Type:  Sets the level of processing of the data.  The data type is 
selected from a drop down menu, in a hierarchy of increasing processing from 
Interferogram, Single Beam, Transmittance or Absorbance. 

3. Starting Wavenumber:  Sets the lower limit of the wavenumber range to be 
computed in the fast Fourier transform. 

4. Ending Wavenumber:  Sets the upper limit of the wavenumber range to be 
computed in the fast Fourier transform. 

5. Zero Filling :  Sets the interpolation factor via a drop down menu for smoothing 
of acquired data.  The interpolation factor may take the values 1, 2, 4, 8, or 16.  
Zero filling increases the resolution of the data by Fourier interpolation. 

6. Apodization  sets the type of apodization function to use in the fast Fourier 
transform to remove truncation artifacts.  Triangle, Boxcar, Beer-Norton 
Med, Beer-Norton Weak, Beer-Norton Strong, Happ-Genzel, Bessel, 
Cosine, Blackman-Harris 3 Term and Blackman-Harris 4 Term are 
selectable via a drop down menu. 
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7. Phase Correction:  Sets the type of phase correction function to be used.  
Mertz and Magnitude are selectable via drop down menus. 

 
 
Advanced  Process Parameters are accessed by clicking on the ôAdvanced' button. 
 

1. Laser Frequency:  Used to define the nominal frequency of the HeNe laser 
used as a clock in a Fourier transform infrared spectrometer.  The actual laser 
wavelength will remain unaffected by any changes to the Laser Frequency 
parameter ð historically this number was manipulated to correct for shifts in the 
x-axis. It is recommended that the X-Shift tool is used for this purpose. 

2. Laser Sampling Interval:  The available settings are 0.25, 0.5, 1.0, 2.0, 4.0 and 
8.0.  The bandwidth (full spectral range) of the interferogram data is determined 
by the Laser Frequency and the Laser Sampling Interval.  For instance, if the 
laser frequency is 0.63299, the wavenumber bandwidth is 10000 / 0.63299 / 2 , 
or 7899 cm-1 (the division by 2 is called for by the  Nyquist theorem).  However, 
if data is sampled more often, say twice every laser cycle, the bandwidth is twice 
that, or 15798 cm-1.  The value of 0.25 corresponds to taking 4 samples every 
laser cycle, 0.5 to 2 samples, 1.0 to 1 sample, and so on. 

3. Sampling Direction:  The available settings are Automatic Detection, 
Forward, Reverse, or Both.  An infrared spectrometer can take data when the 
mirror is moving forward, backward, or in both directions.  Essential FTIR will 
automatically detect when the data is Bi-Directional (Both) or not. In the case 
where the data is not bi-directional, it is assumed to be Forward.  This setting is 
can be used to manually tell the program how to handle the data.  After the FFT 
is done, the audit trail will contain information about what the software used for 
interferogram direction.  When collecting and processing data from an 
instrument, this setting is typically taken from the instrument and such an 
instrument setting will over-ride whatever is specified here. 

4. Interferogram Symmetry:  The available settings are Automatic Detection, 
Single-Sided and Double-Sided.  Single sided interferograms are sometimes 
called ôasymmetricõ and double sided ôsymmetric.  An infrared spectrometer can 
initiate data collection such that the ZPD is placed in the middle or near the 
beginning of the interferogram.  This setting can be used to tell the software how 
to handle the data, because single and double sided interferograms are apodized 
differently.  Like the Sampling Direction setting,, the audit trail will contain 
information about what the software used for interferogram symmetry.  When 
collecting and processing data from an instrument, this setting is typically taken 
from the instrument and such an instrument setting will over-ride whatever is 
specified here. 

5. Normalize Singlebeam:  After the data is FFTõd, some software will scale the 
data by the inverse of the number of FFT points. This setting is here so the you 
can produce data compatible with data from other software. 
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Align 
 
These settings determine how data is displayed when the Align mode of data collection 
is used.  Align mode is used to help tune the instrument to maximize the signal 
throughput.  The Align page is shown in figure 4.26. 
 

 
      Figure 4.26  Align parameters  
 

The parameters for Align mode begin at row 2. 
 

1. Align Resolution:  The resolution used when aligning the spectrometer is 
selected from a drop down menu.  The resolution options are identical to, but 
independent of, the resolution settings for data acquisition detailed in the 
Collection parameters page. 

2. Show Volts:  A check box toggles between displaying voltage or analog-digital 
converter counts.  These numbers relate to the magnitude of the interferogram. 

3. Peak-to-Peak Volts:  Sets the peak to peak voltage for the instrument. This 
number is needed to convert ADC counts to Volts  As with option 2, this range 
is proportional to the magnitude of the interferogram. 

 

Storage 
 
The Storage parameters page is shown in figure 4.27 
 

 
Figure 4.27 Storage parameters 
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The storage parameters begin at row 2. 
 

2. Save these Sample Data Types:  Offers the choice of saving any of four kinds 
of data.  On the right of the row, notice the edit button labeled with three 
periods (é).  Clicking this button summons a dialog containing four check 
boxes.  These are labeled Absorbance, Transmittance, Single Beam and 
Interferogram.  Checking Interferogram, while leaving the other options 
unchecked, will save only the raw interferogram to disk.  Adding the Single 
Beam option will additionally save the Fourier transform of the interferogram to 
disk.  Checking the Transmittance box will enable saving of the ratio of the 
single beam against the current or selected background.  Finally, and as is 
recommended, if all boxes are checked the Absorbance spectrum (negative 
logarithm of the transmittance spectrum) will also be saved. 

3. Save these Background Data Types:  When recording background spectra, 
two options are available for data storage.  These are Interferogram and Single 
Beam.  Again, it is recommended that all data types be saved to disk. 

4. Root Storage Directory:  Defines the default directory to which data is saved.  
Clicking the edit button (é) summons a dialog allowing you to specify or create 
a folder for data collection. 

5. Enable Backups:  Toggles on or off automated backing up of data ð see line 6.  
If backups are enabled, new data is automatically copied to the backup directory 
as it is generated. 

6. Root Backup Directory:  Enables you to set the directory for backups of 
collected data.  This may be on a different drive from the original data, thus 
providing insurance against disk failure. 

7. File Naming Scheme:  A drop down menu allows specification of the system 
for naming consecutively collected files.  Three options are available ð Time 
Stamped, where files are named according to the time of acquisition (on the 
computer clock), Sequentially Numbered, where each file is named with an 
number which is incremented each time a spectrum is acquired, and 
Sequentially Numbered in 8.3 Format., where the incremental numbering is 
observed in accordance with the old DOS format.  This results in eight-character 
filenames (padded with leading zeros) and three character file extensions, hence 
the term 8.3. 

8. Filename Prefix:: The editable text box in row 8 accepts a string, which is used 
as a prefix for file names, unless the File Naming Scheme is set to ôTime-
Stampedõ For instance, if the filename prefix is ôbrõ and the filenaming scheme is 
ôSequentially Numbered in 8.3 Formatõ, the first filename will be ôbr000001õ, the 
second ôbr000002õ, and so on.   

9. Filename Seed:  Provides the starting number for sequentially numbered data 
files.  Note that if the 8.3 format detailed in option 7 is applied, an absorbance 
file with the seed ò1ó will become 00000001.abs 

10. Prompt for Filename:  Checking this box instructs the program to offer a file 
naming and saving dialog box after each data file is collected.  

 
The Storage settings collectively control the names of acquired data files.  As an 
example, consider the results of settings where option 7 is set to Sequentially 



 47 

Numbered in 8.3 Format, option 8 is set to òtestó, option 9 is set to ò1ó and option 11 
is set to Use .spc Extension.  The name of the fourteenth file acquired under this 
scheme would be: test0014.spc 
 

Repeat Sampling 
 

The Repeat Sampling parameters page is shown in figure 4.28. 
 

 
       Figure 4.28   Repeat  Sampling parameters 
 

The Repeat Sampling parameters begin on row 2. 
 

2. Sample Fast:  Collects spectra immediately upon finishing the previous 
collection, regardless of other settings specifying wait times. 

3. Sampling Frequency:  The edit box is used to specify a time interval for 
sampling.  The interval may be input in an HH:MM:SS format, where HH is 
hours, MM is minutes and SS is seconds.  This parameter is ignored if the 
check box in line 2 is selected. 

4. Sample Forever:  Instructs the software to continuously sample indefinitely.  
This command will override the contents of line 5. 

5. Sampling Duration:  An edit box in HH:MM:SS format allows specification 
of duration for sampling.  The instrument will sample continuously according 
to the Sampling Frequency parameter until the duration is reached.  This 
parameter is overridden by the previous Sample Forever check box in line 
4. 

6. Max Spectra.. During Repeat Sampling, every spectrum is displayed. When 
collecting hundreds, or even tens of thousands of spectra, the program 
would quickly run out of memory unless the number of spectra held in 
memory is restricted.  This setting determines the maximum number of 
spectra that will be displayed at one time. In the figure, the setting is 50. 
After 51 spectra are collected, the 1st spectra will be removed from the 
display so that the 51st can be displayed.  This setting does not have any 
affect on the saving and storage of data, only on the display of the most 
recent  data. 

 

Instrument 
 

The Instrument options are shown in figure 4.29. 
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Figure 4.29 Instrument options 
 

Only row 2 contains instrument options.  The drop down menu contains a list of 
instruments with which Essential FTIR is compatible.  Drivers will be provided if a user 
requires an interface with an instrument not on the list.  The Emulator option may be used 
to gain familiarity with the software while not connected to a spectrometer.  The list of 
instruments may vary depending on the type of instrument you have and the way the 
instrument is interfaced to the computer. 
 
The next five options on the menu ð Display, X-Axis Direction, X Fixed Limits , Y Fixed 
Limits  and Printing  are discussed in detail in the Display section, from figures 2.6 ð 2.21. 
 

Miscellaneous Options 
 
The final option we are concerned with in this section is the miscellaneous parameters.  
These parameters are shown in figure 4.30. 
 

 
Figure 4.30 Miscellaneous parameters 
 

The Miscellaneous options run from row 2 to row 7. 
 

2. Time Format:  The format in which the time is displayed ð see table below. 
3. Date Format:  The format in which the date is displayed ð see table below 
4. File Associations: Clicking this button summons a dialog box containing check-

boxes.  These boxes are used to select file extensions that you wish to associate with 
Essential FTIR.  When a file is associated with Essential FTIR, then double-
clicking that file in Windows explorer will open the file using Essential FTIR, in an 
manner similar to .doc files being associated with Microsoft Word.  This integration 
with Windows greatly extends the power of the program, and it is highly 
recommended that you associate all spectral data files with Essential FTIR. 

5. Check at Startup: This check-box is used to select whether Essential FTIR 
should check file associations each time the program is started.  It is recommended 
that this box is left checked. 

6. Startup Help:  This check-box selects whether a Help  workspace window is 
summoned upon starting Essential FTIR.  If the box is left unchecked then no 
help page will be shown when starting the software. 
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7. Startup Help Screen: The edit button (é) is used to choose which help page is 
loaded upon starting the program, assuming the Startup Help check-box in row 6 is 
selected.  This option enables customization of the information shown to you on 
starting Essential FTIR .  The help pages are in the standard HTML format. With 
this option the software can be customized to display information specific to the site 
or application. 

 
The date and time formats may be set using the scheme shown below, in conjunction with 
options 2 and 3. 

 
%a   Locales abbreviated weekday name. 
%A  Locales full weekday name. 
%b  Locales abbreviated month name. 
%B  Locales full month name. 
%c  Locale's appropriate date and time representation. 
%d  Day of the month as a decimal number [01,31]. 
%H  Hour (24-hour clock) as a decimal number [00,23]. 
%I  Hour (12-hour clock) as a decimal number [01,12]. 
%j  Day of the year as a decimal number [001,366]. 
%m  Month as a decimal number [01,12]. 
%M  Minute as a decimal number [00,59]. 
%p  Locale's equivalent of either AM or PM. 
%S  Second as a decimal number [00,61]. 

%U  

Week number of the year (Sunday as the first day of the week) as a decimal number 
[00,53]. All days in a new year preceding the first Sunday are considered to be in 
week 0. 

%w  Weekday as a decimal number [0(Sunday),6]. 

%W  

Week number of the year (Monday as the first day of the week) as a decimal number 
[00,53]. All days in a new year preceding the first Sunday are considered to be in 
week 0. 

%x  Locale's appropriate date representation. 
%X  Locale's appropriate time representation. 
%y  Year without century as a decimal number [00,99]. 
%Y  Year with century as a decimal number. 
%Z  Time zone name (or by no characters if no time zone exists). 
%%  A literal "%" character. 

 

TheTools Menu 

 
The Tools menu contains the Essential FTIR features which give the program its power.  
The Tools menu is shown in figure 2.31. 
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Figure 4.31 Tools menu 

 
The Toolboxes and Tools presented by the Tools menu may be accessed either using this 
menu, or by using the Toolbox Selection Window.  The methods of access are equivalent, 
though there are differing schools of thought on which method is more intuitive.  The menu 
system is a familiar feature of software running on Microsoft Windows systems, and many 
users find that this familiarity allows them to feel comfortable with Essential FTIR more 
quickly.  However, the Toolbox Selection Window is designed to make all tools accessible 
with a minimum of mouse movement, and once the you are familiar with this interface it is 
usually the faster method of access.   
 
As with other program features where redundancy is employed in an effort to provide you 
with the most intuitive and comfortable access options, we must make a choice concerning 
which section is most appropriate in which to present the features.  As it will be necessary to 
present a section on the Toolbox Selection Window, we will provide a detailed description 
of all Toolboxes and Tools in that section.  The only feature unique to the Tools menu is 
the Show/Hide Toolbox option, which allows toggling of the Toolbox selection window.  
This feature may be used to create more room at the bottom of the screen for tools, if  you 
intend to access features solely using the menu bars. 

 

The Help Menu 

 
The Help menu is shown in figure 4.32. 
 

 
Figure 4.32 Help menu 
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The Help  menu provides a number of features.  The first item on the menu, the Help 
Index, allows you to display a page containing Links  to instructions and information on the 
functions of Essential FTIR. This Help is a separate file named ôeftir.chmõ, and is displayed 
in the standard Windows help file viewer: 
 

 
Figure 4.33 The Help File. 
  
 
 
The Submit Bug Report option may be used should you encounter any irregularities or 
problems with Essential FTIR.  The computer used must be connected to the internet in 
order to use the option.  This feature allows the producers to react quickly to any problems. 
The Activate License feature is used whenever a user needs to upgrade a license for 
Essential FTIR ð for example, when switching from a trial version to the fully licensed 
product.  Two options exist for activation ð Internet Activation or Manual Activation.  
These options require a user name and a code for activation ð these will be provided to 
license holders. 
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The Check for Newer Version option contacts the Essential FTIR website ð 
www.essentialFTIR.com - to determine if a later version of the program is available, and if 
such a version is found you will be prompted to download and install the updated version.  
This will not affect any previously collected data.  This option assumes that an internet 
connection is present on the computer running Essential FTIR. 
 
The Visit Essential FTIR.com option may be used to connect to the official Essential 
FTIR website ð www.essentialFTIR.com -, which contains information and downloads 
relevant to the program, 
 
Finally, the About Essential FTIR option provides information on version number, build 
number, copyright and other information regarding the software. 
 
 
 
 
 
 
 

Toolboxes and Tools 
 
In this section we will examine the toolbox window.  The toolbox window is pictured in 
figure 5.0. 
 

http://www.essentialftir.com/
http://www.essentialftir.com/
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Figure 5.0 Toolbox window 
 

The Toolbox window is the heart of Essential FTIR.  It is from this window that you may 
choose and apply many features to enhance, interpret and analyze spectral data.  The 
features offered by the Toolbox are also available from the Tools menu.  However, the 
Toolbox is designed to offer maximum utility with a minimum of cursor movement, and 
many users find the Toolbox a more ergonomic way to access the tools offered by Essential 
FTIR .   
 
 
 
The Toolbox window organizes the Tools into categories.  The categories are: 
 

¶ Data 

¶ Manipulations 

¶ Conversions & Corrections 

¶ Analysis 

¶ Synthesize / Edit Data 

¶ Advanced 

¶ Favorites 
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A one-line summary of the tool currently selected is displayed below these options ð in the 
case of the active tool shown in figure 5.0 ð the Data Browser - the summary reads òBrowse 
the disk for data filesó.  Each Toolbox is selectable by clicking on the appropriate tab in the 
Toolbox Selection Window, and each individual Tool is accessed by clicking on its label..  
We will examine each Toolbox and its contents in turn. 

The Favorites 
 

The Favorites Toolbox gives a user a place to organize the tools they most often, and to 

specify a particular tool that should be made active every time Essential FTIR is started. 

Also, the name óFavoritesô can be changed to something else, for instance óTechnician 

Toolsô.  

 

When you first open the Favorites tool box, you will see a button labeled óAdd Tools to 

this Toolboxô: 

 

 
 

 

 



 55 

Clicking the button will bring up this Dialog box: 

 

 
 

 

In this next picture, the name of the óFavoritesô has been changed, some tools have been 

selected by placing check marks next to them, and one of the tools has been chosen as the 

startup tool: 
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The óFavoritesô button will display the label óStudent Labô, the óStudent Labô toolbox will 

have five  tools: óFTIR Spectrometerô, óUser Library Searchô, óManual Baseline 
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Correctionô, and óPeak Pickingô.  In addition, when the program starts, the óFTIR 

Spectrometerô tool will be displayed right away. Because the óHide other toolboxesô 

button is checked, only these tools will be available. 

 

 

Changes to the óFavoritesô toolbox require that Essential FTIR be closed and restarted to 

be applied. When you click óOKô on the dialog, you will see this message: 

 

 
 

 

When Essential FTIR is restarted, the toolbox will look like this, and will start up with 

the óFTIR Spectrometerô data collection tool. 

 

 
 

 

The óFavoritesô Tool is a way to tailor the program to display only those tools that are 

relevant to a particular task.  It can make the software easier to use by gathering the tools 

you use most often into one group.  
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The Data Toolbox 
 
The first Toolbox in the list is labeled Data.  The Data section houses all the Tools 
concerning data location, data loading, data acquisition, library searching, file and graphics 
exporting and file header information.  We will examine each Tool in detail. 
 

File Browser 
 
The first Tool in the Data Toolbox is the File Browser, which is shown together with its 
associated Tool Parameters Window in figure 5.1. 
 

 
Figure 5.1 Parameters for the File Browser Tool 
 

In figure 5.1 the extreme left of the window is taken up by the Data Toolbox.  The central 
portion of the window is occupied by the File Browser itself.  This tool allows you to 
browse files in a way familiar to most users of Microsoft Windows.  By selecting a drive ð 
either a local disk or removable volume ð and navigating to the desired folder the data may 
be loaded directly into the active Workspace.  If no Workspace is currently open then one 
will be created.  Two additional options exist for navigation, you may either use the Explore 
from Here button ð which launches the Windows file browser ð or by clicking the Browse 
Dialog button, which summons a traditional Microsoft Windows òopen fileó dialog.  A 
single click on a recognized data file displays that file in the browser pane on the right of the 
window.  The data file may be loaded into the Workspace, either by clicking the Add to 
Current Window button, or by double-clicking the data file.  Additionally, the selected file 
may be loaded into a new Workspace by clicking the Add to New Window button.   
 
Multiple files may be selected in the standard manner ð by holding the Shift key while 
selecting the first and last files, or, for if the desired files are discontinuous, by holding the 
ctrl key while selecting the files.  The multiple files selected may be loaded by right-clicking 
on the files and selecting either the Load all selected files in a new window or Load all 
selected files in current window options from the context menu.  The Add to Window 
buttons function as normal.   
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The directory may also be labeled as a favorite by clicking on the Add to Bookmarks 
button.  At the top of the File Browser are three tabs.  By default, the first tab is active ð the 
Browse Files tab.  The second option is the Load Files from Bookmarks tab, shown in 
figure 5.2. 
 

 
Figure 5.2 Load Files from Bookmarks tab 

 
The tab displays a list of options for browsing, including a list of Bookmarked files, defined 
using the Add to Bookmarks button described above. 
 
The third option available is the Manage File Filters tab, shown in figure 5.3. 
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Figure 5.3 Manage File Filters tab 

 
This option allows the you to filter the files displayed in the browser window by format.  As 
in most cases it would be counter productive to list files not compatible with Essential 
FTIR .  A list of file formats is displayed, selectable via a checkbox next to each format. 
 

Collect New Data 
 
The Collect New Data feature is the Tool used to acquire spectra on a Fourier transform 
infrared spectrometer.  The associated parameters window is shown in figure 5.4. 
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Figure 5.4 Collect New Data parameters 
 

The parameters window consists of six tabs: 
 

¶ Collection 

¶ Process 

¶ Align 

¶ Storage 

¶ Repeat Sampling 

¶ Instrument 
 
These Collection parameters are also available for editing via the Setup selection from the 
Options menu.  These parameters are described in detail in chapter four, from figure 4.23 to 
figure 4.28.  Before beginning a collection, it is important that the desired parameters for 
these six sets of options are configured, either using the tabs provided or from the menu 
system described in chapter four.  
 
Though the collection parameters are available through the menu system, in order to collect 
spectra, the Collect New Data tool must be used.  Figure 5.5 shows the Collect New Data 
controls. 
 

 
Figure 5.5 Collect New Data controls 
 

The controls consist of a Start button, a series of radio buttons, a background spectrum 
drop down menu, a Browse button and a Help  button.  At this stage, it will be helpful to 
briefly summarize the steps involved in collecting valid FTIR data.   

¶ A background spectrum must be collected.  FTIR is a single beam technique; 
therefore background data is needed in order to interpret the sample data.  This is 
apparent from Beerõs law, which states that T = I0 / I, where T is the fraction of 
infrared energy of a given wavelength reaching the detector, I0 is the background 
single beam spectrum and I is the sample spectrum. 

¶ Depending upon the final data type selected from the Collection parameters, the 
interferogram may be Fourier transformed from the time domain to the frequency 
domain to create a single beam sample spectrum.   
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¶ The ratio of the single beam sample spectrum and the background spectrum may 
then be computed to give the fractional transmittance spectrum.   

¶ Finally, the negative logarithm of this transmittance spectrum may be computed to 
give an absorbance spectrum.  The absorbance spectrum is linearly related to the 
concentration of absorbing species whereas the transmittance spectrum is 
logarithmically related. 

 
A background spectrum is collected by selecting the Background radio button and pressing 
Start.  A previously saved background spectrum may also be loaded from disk using the 
Browse button.  Once the background single beam spectrum is collected, and the final data 
type (interferogram, single beam, transmittance or absorbance spectrum) is selected, the 
radio buttons should be used to select either Sample or Repeat Sample.  The repeat 
sample parameters may be set as shown in chapter five.  An example of the use of the 
Collect New Data tool is given in the chapter six tutorial. 
 

Display Setup 
 
The Display Setup Tool is identical to that detailed in figures 4.5 to 4.16.  Please refer to 
this section of the manual for information on this Tool. 
 

File Finder 
 
The File Finder is, as its name implies, a method for searching disks for specific files or sets 
of files.  The parameters window for the File Finder Tool is shown in figure 5.6. 
 

 
Figure 5.6 File Finder Tool 
 

The Tool has three main parts.  In the upper portion of the File Finder window are three 
drop down menus for the entry of wild card characters, text and the directory to search.  On 
the bottom left is a browser, used to select files identified by the search.  The display window 
in the bottom right of the screen shows any file highlighted in the browser window. 
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Addressing each of the File Finder elements in turn, letõs examine the three drop down 
menus.  The first ð Wildcards ð enables selection of file extensions to search for.  In the 
example used in figure 5.6 the file extensions .dx and .jdx are included in the search, which 
are the file extensions used by JCamp-DX.  The wildcard characters * is used to signify that 
the portion in front of the file extension is not relevant.  In the second drop down menu text 
may be entered or selected from previous searches.  This text is then included as part of the 
search.  The search is not case sensitive, the text ôacidõ will match both ôacidõ, ôAcidõ and 
ôACIDõ.  Entering text to search for is optional, if no text is provided then the Finder will 
find all files with the given extension(s). The third drop down menu is used to select drives, 
directories and folders for searching.  The search folders may also be specified using the 
Browse button.  This drop down list is pre-populated with book-marked folders. If ôSearch 
Current Results Onlyõ is checked, then only the files listed in the file list box are searched. 
This provides a way to narrow down the search using multiple search texts.  If ôReverse 
Searchõ is checked, only files that do not contain the search text are listed. 
 
Pressing the Start Search button begins the search.  Subdirectories are included in the 
search by checking the box next to the Start Search button.  Once the search is concluded 
the browser portion of the window is populated with a list of the files found.  These may be 
viewed in the display window by clicking once on the file.  Multiple files may be selected in 
this list using the mouse in combination with the shift and control keys. The selected files 
found may be loaded to the active Workspace by clicking the Add to Current Window 
button, or loaded to a new Workspace by clicking the Add to New Window button. 
 

File Conversion 
 
The File Conversion Tool is a utility that enables you to change the format of data files.  
The File Conversion parameters window is shown in figure 5.7. 
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Figure 5.7 File Conversion utility  
 

At the top of the File Conversion parameters window are five inputs.  Taking each in turn: 
 

¶ Source of Data:  A drop down menu allows the selection of a number of options 
for source data.  You may choose Pick Files From Disk, All Visible Files In 
Current Window, All files in Current Window or Entire Directory. 

¶ Fill the list:  The Fill the list button populates the window at the bottom of the            
parameters screen with the chosen files.  If the Pick Files From Disk or Entire 
Directory options are chosen then clicking the Fill the list button summons a file 
browser dialog box.  

¶ Destination:  The Destination option enables you to select a destination directory.  
By clicking the edit button (é) a browser dialog is summoned that allows selection 
of a folder or the creation of a new folder to accept the incoming converted files. 

¶ Over-Write:  A check box toggles between states of over-writing any files of the 
same name as the incoming files already present in the destination folder. 

¶ File Type:  Specifies the format of the result of the conversion.  You may choose 
between Galactic, Perkin-Elmer, JCAMP-DX or ASCII formats. 

 

File Conversion Example 
 

 
 

1. Select the File Conversion Tool in the óDataô category. 

2. Pick the source of the data. The choices are: 

 

"Visible Files in Current Window" 

"All files in Current Window" 

"Pick Files From Disk" 

"Entire Directory" 
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3. The óClick to Fill button can be used to refresh the list of files to convert. 

4. Pick a destination folder for the converted files.  In this case, note that the source 

and destination are the same. 

5. Pick the format the files will be converted to. The choices are: 

 

"PE (.SP)" 

"Galactic (.SPC)" 

"JCAMP-DX (.DX)"  

"ASCII Table (.CSV)ò 

 

6. Click óApplyô 

 

 

In this example, a folder of JCamp-DX files is converted to Galactic .spc format in-

place, meaning the source and destination folders are the same. 

 
 
 

FDM Library Search 
 
The FDM Library Search allows Essential FTIR  users to search unknown spectra 
against FDM FTIR spectral libraries.    If an FDM library is not already installed on your 
system, a trial library is available for download at   www.fdmspectra.com.   
 
The FDM Library Search parameters are shown in figure 5.8. 
 

 
Figure 5.8 FDM Library Search parameters 
 

http://www.fdmspectra.com/
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The Installed Libraries window is visible toward the top of the parameters screen.  This 
window displays the FDM libraries available for searching.  Each library may be toggled 
between searchable and un-searchable states using the check-box corresponding to that 
library.   
 
Above the Installed libraries window are three buttons.  The Search button initiates a 
search for the best match to the currently selected spectrum in the active Workspace, under 
the current parameters.  The Next Spectrum and Previous button allow navigation 
between spectra in the active Workspace. 
 
In the lower portion of the parameters window are six tabs.   
 

The Library Spectra Tab 

 
Pictured in figure 5.9, the Library Spectra tab contains the list of compounds contained in 
the currently selected library. 
 

 
Figure 5.9  Library Spectra tab 
 

By selecting a name in this list you can see the corresponding spectrum in the current data 
window. This allows you to browse through the data in the library like a reference book. 
Only files contained in the library currently highlighted are displayed in the Library Spectra 
tab. 
 
The order in which the entries are displayed can be changed by clicking on the ôEntryõ or 
ôNameõ column headers.  The same is true of information displayed in other lists. 
 

Search Hit List 
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The Search Hit List tab, shown in figure 5.10, displays the closest matches to the active 
spectrum in the workspace.  This list becomes populated when you press the Search button. 
 

 
Figure 5.10 Search Hit List tab 
 

There are four columns in the tab.  The first is labeled Score, which provides information 
on the quality of the match between spectra.  The òhitó library spectra are ranked according 
to this score.  The order of ranking may be reversed by clicking on the arrow button on the 
Score column label.  The files in the hit list may be sorted by name, entry number or library, 
by clicking on the column heading.  The significance of the number listed in the Score 
column depends upon the search algorithm used.  The search algorithm is selected from the 
Settings tab.  In the example given in figure 5.10 the correlation coefficient between the two 
spectra is used as the ranking number, 1 being perfect correlation and 0 being no correlation.  
The best match according to correlation coefficient is 1,2-dimethybenzene, or ortho-xylene.   
 

Enhanced Scoring and Hit List Ordering 
 
The use of the FTIR search algorithms taken as-is from the literature creates results sorted 
either for a maximum or minimum score. For instance, a perfect score with the Correlation 
Coefficient algorithm is 1.0 while with other algorithms the best scores are minimal, i.e. close 
to zero. To avoid this predictable and mildly confusing problem we have inverted the scores 
from algorithms that are normally use minimal scoring. Thus, FDMõs Enhanced Scoring 
simply means bigger scores are better and users donõt have to think about it any more. 
 
The highlighted library spectrum and sample spectrum are displayed together in the 
workspace shown in figure 5.11. 
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Figure 5.11 Sample spectrum and best match from search 

 
The second column in the Search Hit List tab is labeled Name.  The name of the file 
corresponding to the ranking score is displayed in this column.  The third column is labeled 
Entry, and lists the index number of the spectrum in its library.  The fourth column is 
labeled Library, and lists the FDM library containing the spectrum. 
 

Text Search 

 
The Text Search tab is shown in figure 5.12. 
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Figure 5.12 Text Search tab 
 

The Text Search feature allows you to find files in the FDM library containing character 
strings matching the search text.  In the example given in figure 5.11 the search text is 
òbenzeneó.  The search then delivers the library files containing the word òbenzeneó in the 
title.  The search is not case sensitive.  Two check-boxes are situated above the search results 
window.  The box labeled Search Within These Results allows you to conduct a search of 
the files returned by the Text Search, allowing you to narrow the results of the search.  The 
box labeled Reverse Search excludes files containing the search text and returns all files 
where the search text is absent. 
 

Search Settings 

 
The Settings tab is shown in figure 5.13. 
 

 
Figure 5.13 Settings tab 
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On the Settings tab there are three rows of options.  The first ð Number of hits ð specifies 
how many matching spectra are displayed.  This number may be selected in multiples of 10 
from the drop down menu.   
 

The next option is Search Algorithm.  Any of the algorithms offered will perform a 

satisfactory search.  However, special situations exist where one algorithm may be favored 
over another.  The options available for selection from the drop down menu are 
 

¶ Correlation Coefficient ð  The product-moment correlation coefficient 
between the library spectrum and the sample spectrum.  This algorithm may be 
employed even when baseline defects such as slope and offset are present, as the 
method scores results by correlation.  Correlation is not a relative measure of òbest 
fitó, but an absolute value with statistical significance.  The main disadvantage of this 
algorithm is the processing time ð it is the slowest option available.  The equation for 
the Correlation Coefficient is: 
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Where x and y are the data points on the sample and library spectra, and x-

bar and y-bar are the means of the data. 

 

 

¶ Euclidean Distance ï The Euclidean distance between two points.  This 

algorithm is recommended when searching unknown mixtures, as it is not as 

sensitive to differences in spectra as are other algorithms.  Results for this 

algorithm may not be produced by others.  However, the Euclidean Distance 

method is slow, and may be inconclusive in the presence of baseline slope or 

other defects.  The equation for Euclidean Distance is: 
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Where E is the Euclidean distance and P and Q are corresponding points on 
the sample and library spectra. 

  

¶ Absolute Distance ð A special case where the distance is considered to be an 
unsigned scalar quantity.  The absolute distance algorithm emphasizes peak heights, 
and is the fastest algorithm.  However, results may be inconclusive in cases where 
search spectra have sloping baselines.  The equation for Absolute Distance  is: 
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Where A  is the absolute distance and Pi and Qi are corresponding points on 
the sample and library spectra. 

 

¶ Least Squares ð Reports the best fit based on minimizing the sum of the squares 
of the residuals.  The equation for Least Squares is: 
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Where S is the sum of the squares of the residuals, y is the library data and x 

is the sample data. 
 

First derivative version of these search algorithms perform the same searches but with the 
first derivative of both the unknown and library spectrum. A key advantage of first derivative 
search algorithms is they are relatively forgiving of baseline problems including broad 
backgrounds. For this reason the Raman community prefers to search with first derivative 
algorithms. 
 
The third option on the Settings tab is a Region Search, which permits searching of the 
library spectra over a defined region.  The region is set by right-clicking on the sample 
spectrum in the Workspace to set the two extremes of the region to be used in the search.  
The region is then displayed in the Region Table at the bottom of the window.  Please refer 
to the section on region creation in chapter three for a detailed discussion of Regions.  An 
example of a Region set for  a library search is given in figure 5.14. 
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Figure 5.14 Searching a region 

 
Once set, these regions may be re-positioned by left clicking the region marker and dragging 
to the desired value.  The regions may be deleted either by right-clicking on a region marker 
or by right-clicking in the Region Table and selecting Remove Selected Row from the 
context menu.  Regions may also be saved and loaded using the context menu. 
 

Library Info  

 
The Library Info  tab provides information on the FDM library(s) used in the search.  The 
Library Info  tab is shown in figure 5.15. 
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Figure 5.15 Library Info tab 
 

Licenses 

 
The Licenses tab provides information on your licenses currently available for FDM 
spectral libraries.  The Licenses tab is shown in figure 5.16. 
 

 
Figure 5.16 Licenses tab 
 

The Licenses tab shows the available servers in a browser window on the left.  When a 
server is highlighted, the libraries contained in that server are displayed on the right, along 
with their license information.  Multiple servers maybe installed and licensed at the same 
time. This allows for conveniently adding more spectral libraries simply by installing 
additional servers. A server may hold one or more FDM libraries. 
 
The Activate License button summons the dialog box shown in figure 5.17. 
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Figure 5.17 Activate Licenses dialog box 
 

The Name and Key parameters are supplied upon purchase of a license.  The Cancel 
button dismisses the dialog without further action, while the OK button completes the 
registration.   

 
The FDM Library Search and Essential FTIRõs Full Featured Trial mode vs free File 
Viewer mode 
 
The FDM Library Search will function if the libraries have an active trial license or a 
permanent license AND Essential FTIR is installed and running in trial mode, is 
permanently licensed or in free file viewer (i.e. expired trial) mode. 
 
If any FDM trial license has expired the spectra will no longer be viewable. However the 
chemical names may still be browsed and searched. 
 
SPECIAL NOTE: The trial license and trail period for the FDM libraries is an entirely 
separate matter from the Essential FTIR trial license period. While these two products are 
tightly integrated they are from two different companies. To buy an Essential FTIR 
permanent license visit http://www.essentialftir.com. To buy FDM permanent licenses visit 
http://www.fdmspectra.com. 
 

http://www.essentialftir.com/
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User Library Search 
 
Users may build their own libraries of spectra for searching. In Essential FTIR, a library is 
nothing but a disk directory containing individual data files. Users may add and remove 
spectra from ôlibrariesõ simply by using windows file explorer to move files in and out of 
these directories. The files must be in Galactic .spc format, and must have the .spc file 
extension.  Please see the ôFile Conversion Exampleõ in the ôFile Conversionõ section of this 
manual for help in converting files to the Galactic format. 
 
The User Library Search Tool operates on the same principle as the FDM Library 
Search detailed above in that a sample spectrum is compared to library spectra, which are 
then ranked according to their similarity to the sample spectrum.  The main difference 
between the searches is that in this case you may build their own FTIR spectral library for 
the purposes of searching.  You may designate any folder containing valid FTIR absorbance 
or transmittance spectra as a library using the Libraries button.  The Libraries button 
summons the dialog box shown in figure 5.19. 
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Figure 5.18 User Library Search Tool showing the search results. 
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The Settings Tab controls the search settings. 
 

 
 

¶ Number of hits: This many hits will be displayed in the ôSearch Hit Listõ. 

¶ Report Hits: When generating a search report, the number of hits printed in the 
report can be limited independently of the number displayed on screen. 

¶ Report Scores: When generating a search report, you may not want the search scores 
to be included. 

¶ Search Algorithm: This allows you to control the method used for matching spectra. 

¶ Region Search: If checked, the matching of spectra will only be done over the 
regions you select. 

 
 
 

 

 
Figure 5.19 The Library Maintenance dialog box  
 

The main window of the Library Maintenance dialog box contains a list of searchable 
libraries, each with a corresponding check-box which may be used to select or de-select that 
library from a search.  There are also buttons on the right.  At the top right of the dialog box 
is the Add eFTIR User Library button, which summons the secondary browser dialog box 
shown in figure 5.19, labeled Choose a Library Directory.  Selecting a folder in this 
browser and clicking OK results in that folder being treated as a searchable User Library.  
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Essential FTIR can also search libraries that have been created in other FTIR software 
packages: Grams/Spectra-Calc libraries, known as ôSpectralIDõ libraries, Sadtler user 
libraries, and Mattson WinFIRST libraries. Clicking these buttons will bring up a dialog 
allowing you to choose one of these types of libraries. The next button down is the Remove 
Selected button, which is used to remove the highlighted library from the list.  This action 
will not delete the folder or library; merely remove it from the list of designated libraries.  
The Move Up button shifts the folder up in the list so as to be searched earlier.  The Move 
Down button is used to shift a library down the list.  The Help button, as before, is used to 
summon the Help pages.  The OK button at the bottom right of the main dialog box is used 
to apply and save the changes to the libraries list.  The Cancel button dismisses the dialog 
box without changes. 
 
As with the FDM Library Search, the Search button in the window shown in figure 5.18 
initiates a search of the specified libraries for the best match to the sample spectrum.  The 
check-box labeled Full Spectrum Search instructs the program to search over the whole 
spectrum when checked.  When left unchecked, the software will search based upon the 
regions defined, either by right-clicking on the sample spectrum in the workspace or by 
right-clicking in the Regions window and loading the desired Region Table from via the 
context menu. 
 
The results are ranked in the column on the right of the parameters window, with four 
columns defining the result.  The first column, labeled Metric, displays a measure of the fit 
between the sample and library spectra.  The closer this value approaches 1, the better the 
fit.  The second column, labeled Filename, displays the name of the file which fits the 
sample spectrum to the degree indicated by the metric to its left.  The next column is labeled 
Library, and indicates of which library the òhitó spectrum is a member.  The final column, 
labeled Memo, displays the memo field information for that spectrum.  Clicking on a 
spectrum displayed in the parameters window as a match for the sample spectrum displays 
that spectrum in the active workspace along with the sample spectrum for visual 
conformation of the match. 
 
The ôExport Hitlistõ button will display a menu of choices: 
 

 
 
Allowing you to export the hitlist to other software packages. 
 
The ôReportõ button will generate a search report in .rtf format. 
 
The ôA<>Tõ button converts the display between Absorbance and Transmittance. Most 
libraries store their data in Absorbance, but many users prefer to view the data in 
Transmittance units.  This button allows you to control the display of the search results. 
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Export Graphics 
 
The Export Graphic Tool allows the Essential FTIR user to export presentation quality 
graphics via a variety of formats.  The Export Graphics parameters window is shown in 
figure 5.20. 
 

 
Figure 5.20 Export Graphics 
 

The Export Graphics Tool has two buttons.  The first, labeled Export Current Window 
To File saves the currently active Workspace to a file.  The button labeled Export Current 
Window To Clipboard places the current workspace on the Windows clipboard, for 
insertion into a document. 
 
The parameters window contains four rows.  The first row, labeled Format, contains a drop 
down menu that is used to select the output format for the Workspace graphic.  The 
available choices are: 
 

¶ Portable Network Graphics (.png) -  commonly used on internet web pages. 

¶ Bitmap (.bmp) ð a Windows specific picture format. 

¶ Joint Photographic Expert Group (.jpg) ð the òstandardó compressed image format. 

¶ X Pix Map (.xpm) -  used mostly on Unix systems with the X Window System. 
 
The Width row contains an edit box which allows you to set the width in units of pixels of 
the exported graphic.  The Height  row works in an analogous way.  The Black On White 
option may be used to export the graphic as a grayscale picture, ignoring colors. 
 

Export Data 
 
The Export Data Tool makes it possible to use data collected or viewed using Essential 
FTIR  in other programs.  As has already been stated, FTIR data, whether in absorbance, 
transmittance, single beam or interferogram format may be viewed as two column matrix, 
consisting of an x vector and a y vector, which may be plotted on Cartesian axes.  The 
Export Data Tool allows you to transport one or both of these vectors to any type of 
program capable of handling numerical data.  The Export Data parameters window is shown 
in figure 5.21. 
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Figure 5.21 Export Data parameters 

 
Three buttons are situated at the top of the parameters window.  The Apply button executes 
the settings in the window.  Next Spectrum makes the adjacent spectrum in the 
Workspace active.  The Previous button renders the preceding spectrum in the 
Workspace active. 
 
Five option rows are available.  The row labeled Source of Data includes a drop down 
menu, which is used to select the data to be exported.  The current spectrum, all visible 
spectra in workspace and all files in the workspace are the three options given. 
 
The Export To option offers a drop down menu providing choices on the format of the 
exported data.  The options are: 
 

¶ To the Windows clipboard, from where the data may be pasted into other programs. 

¶ To Comma Separated Values file (.csv) 

¶ To Excel 
 
The final option may be used if Microsoft Excel is installed on the computer running 
Essential FTIR. 
 
The Include X-Axis checkbox should be checked if x axis data (wavenumber, in the case of 
absorbance files) is required. 
 
The row labeled Delimiter  is used to define the character used to delimit the data ð that is, 
to separate individual data points.  Tab should be chosen as a general rule, but other 
circumstances may dictate the use of a comma or other character.  The choices available 
from the drop down menu are: 
 

¶ Comma 

¶ Tab 

¶ Space 
 
The final row is labeled Decimal Places.  A drop down menu allows specification of the 
number of decimal places to include in the exported numeric data.  The data may be 
exported in scientific format, or with decimal places numbering 1-9. 
 
An example of the output of the Export Data Tool, set to export a single absorbance 
spectrum visible in the Workspace to Microsoft Excel, is provided in figure 5.22. 
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Figure 5.22 Exporting Data to Microsoft Excel 
 

The filename of the spectrum exported is visible in the cell 1B of the worksheet. 
 

Saved Workspaces 
 
The Saved Workspaces Tool allows you to save or load a Workspace window.  Three 
buttons are available.  The Save All Windows button summons a dialog box enabling you 
to navigate to the desired folder before saving all Workspaces.  The Save Current Window 
button summons a dialog box which allows you to browse to the desired directory before 
saving the active Workspace.  The Load a Workspace button summons a browser dialog 
box which is used to navigate to a saved Workspace, which may then be opened by clicking 
on the Open button on the browser dialog box.  A Workspace is the window or windows 
open in Essential FTIR and the data that they contain. If there are data that you work with 
often, or if you want to return to particular data later, this tool allows you to save the state of 
the program and restore it later without having to load all the separate data files.  Please refer 
to chapter three for a full discussion of Workspaces. 
 

 
 
Header Information 
 
The Header Information Tool is used to display information contained in the file header 
of the active spectrum.  The Header Information parameters window is shown in figure 
5.23. 
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Figure 5.23 Header Information Tool 
 

The header information is displayed in rows.  The data may be inserted into documents from 
the Windows clipboard via the Export to Clipboard button.  The Next Spectrum and 
Previous Spectrum buttons are used to navigate between spectra in the active Workspace. 
 

Edit Title 
 
The Edit Title Tool  is used to amend the information contained in the Title  row of the file 
information header.  The Title  is a memo field where you may store information regarding 
the data.  The Title  should not be confused with the Filename.  The parameters window is 
shown in figure 5.24. 
 

 
Figure 5.24 Edit Title  
 

The Title  for the active spectrum in the currently active Workspace is displayed in the edit 
box.  Any changes made to the title may be executed using the Apply button.  The Next 
Spectrum and Previous buttons are used to navigate between spectra in the Workspace.  
The Undo button provides an option to roll back any changes made.  The Help  button is 
used to summon the help Workspace. The Save button saves the file in its current location, 
while the Save As button summons a browser dialog box enabling you to select a filename 
and folder for the modified file. 

 

 

Audit Trail 
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In Essential FTIR, a record of all changes to the data is automatically generated, and this 
record (audit trail) is automatically saved with the spectrum when you save the data.  This 
information may be viewed using the Audit Trail Tool , which records any changes made to 
the spectral data.  In the example shown in figure 5.25, the Title  of the spectrum has been 
changed using the Edit Title Tool . 
 

 
Figure 5.25 Audit Trail  
 

The Audit Trail  window shows details of changes made to the active spectrum in the 
Workspace.  The Export to Clipboard button may be used to insert the text of the file into 
a document via the clipboard.  Next Spectrum and Previous Spectrum buttons are used to 
navigate between spectra in the Workspace.   
 

 

The Manipulations Toolbox 

 
The Data Toolbox provides all the options necessary to locate, open, view, edit information 
and save spectral data.  The role of the Manipulations Toolbox is to provide the features 
needed to perform operations on the spectra.  The contents of the Manipulations Toolbox 
are shown in figure 5.26. 
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Figure 5.26 The Manipulations Toolbox 
 

The majority of the Tools we are about to encounter use the concept of Regions.  In the 
context of Essential FTIR we may define a region as: 
 
òRegion ð A portion of the x -axis of a spectrum designated by the user to be 
operated upon, or designated by the user to be representative of that spectrum for the 
purposes of that operation.ó 
 
A detailed treatment of the Regions concept is given in chapter three. Regions may be 
defined by right-clicking in the active Workspace window.  One right-click defines a 
Region Marker ð a vertical line delineating the edge of a Region.  This Region Marker 
may be repositioned by left-clicking and dragging.  Right-clicking in the Workspace window 
a second time completes the Region with a second marker, and the portion of the spectrum 
selected is shaded.  The numerical values of the Region defined in this way are recorded in a 
Region Table, as shown in figure 5.2. 
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Figure 5.27 Region Table 
 
The Region(s) listed in the Region Table may be saved or loaded via the context menu 
summoned by right-clicking in the Region Table, as shown in figure 5.27, or by clicking on 
the Wavenumber column headers.  The menu may also be used to remove rows from the 
table.  In this way once regions have been defined and found successful, they may be 
retrieved later for use in similar circumstances.  Please refer to chapter three for a full 
discussion of the Regions concept. 
 
Different tools in the Manipulations Toolbox (and indeed the Analysis and Synthesize / 
Edit Data Toolboxes) use Regions in different contexts.  For instance, the Zap Tool is an 
example of a feature which uses the Region as a simple definition of a portion of the x-axis 
of the active spectrum to be operated upon.  Put simply, the selected Region is òzappedó, 
leaving the remainder of the spectrum unchanged.  This is not the case with all Tools. 
 
Take the Manual Baseline Correction Tool for example.  A Region selected is not the 
only portion of the spectrum operated upon; rather that Region is taken to be representative 
of the whole spectrum.  The distinction will become clear as we examine each Tool in turn. 

 
Zap 
 
The Zap Tool is used primarily to remove unwanted portions of a spectrum.  For example, 
if a reference absorbance spectrum representing a compound is contaminated it is desirable 
to remove those absorbance peaks not attributable to the compound of interest.  Figure 
5.28shows the Zap parameter window, together with the Workspace display. 
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Figure 5.28 Zap Tool parameters and Workspace window 
 

The Zap parameters window comprises three main elements.  At the top of the window are 
eight buttons: 
 

 The Try button allows you to apply the current Zap settings without 
committing to them.  The parameters will be applied to a gray òghostó spectrum, overlaying 
the actual data. 
 

 The Apply To Current button is used to execute the Zap operation on the 
spectrum.  The original spectrum is replaced in the Workspace by the modified data.   
 

   The Apply to Visible button will execute the Zap operation on all of the 

visible spectra in the workspace. 

 

  The Apply to All button will execute the Zap operation an all of the spectra 

in the workspace, whether they are visible or not. 
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 The Next Spectrum button Selects the next spectrum in the Workspace as 
active. 
 

 The Save button overwrites the original file with the modified version. This 
button has a down arrow, indicating that a menu will be displayed when you click the button. 
The menu displays the various save options. Because you can use the ôApply to Currentõ, 
ôApply to Visibleõ and ôApply to Allõ buttons, there are corresponding Save operations to 
allow you to save all your changes at once.  If you choose ôSave to a Different Locationõ,  
you will be prompted for a destination folder before the data is saved. This allows you to 
save the files without over-writing the original files. 
  

 
 
 

 The Undo button allows you to roll back changes made to the spectrum.  A 
menu is summoned with the options to undo any one of a list of changes, or to undo all 
changes to the spectrum. 
 

 The Clone and Apply button creates a copy of the active spectrum before 
performing the Zap operation upon the copy, thus preserving the original spectrum.  The 
new spectrum becomes the active spectrum in the Workspace. 
 

 The Previous button navigates to the preceding spectrum in the active 
Workspace. 
 

 The Save Asé button summons a navigation dialog box enabling you to 
select or create a folder to contain the modified spectrum. 
 
The above buttons are known as the Toolbox Buttons, and are common to many Tools in 
the Manipulations Toolbox and other Toolboxes.  Users will be referred to this section 
for information on the buttons whenever they are relevant. 
 
The center of the Zap parameters window contains an options table with two rows.  The 
table is shown in figure 5.29. 
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Figure 5.29 Zap options table 
 

The first row of the Zap options table contains a drop down menu with five options ð to fill 
with an interpolated line, fill with zeros, fill with the mean value, fill with the left-most value 
or to fill with the right-most value.  The second row allows you to add noise to the Zap 
Region(s) to avoid an unnatural looking flat line. 
 
The third element of the Zap parameters window is the Region Table., which displays the 
regions to be operated upon.  The Region Table is shown in figure 5.27. 
 

The spectrum shown in the workspace in figure 5.28 is a gaseous sulfur dioxide absorbance 
spectrum at 0.5cm-1 resolution, with 64 co-added scans, with the 10m gas cell heated to 
100C, and regulated to a pressure of 1 atmosphere.  We will use this spectrum, sometimes in 
combination with others, throughout our examination of the Manipulations Toolbox. 
 
Note the four Regions selected in figure 5.28.  The sulfur dioxide spectrum is contaminated 
with water and carbon dioxide ð two very common atmospheric contaminants in gas-phase 
samples.  The Regions are chosen so as to remove the absorbencies due to the 
contaminants.  This contamination is made more obvious in the expanded view shown in 
figure 5.30. 
 
 

 
Figure 5.30 Contamination from H2O and CO2 in SO2 
 

This contamination, while at relatively low levels, can still prejudice the results of a library 
search, or bias a least squares fitting routine for quantification.  If we press the Try button to 
test the effects of the operation on the spectrum, we see the result in figure 5.30. 
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Figure 5.30 Applying the Zap with the Try button 
 

We see that the interferences have been replaced with a flat line, interpolated between the 
Region Markers.  Should we wish, we may apply synthetic noise to the Zap Regions, to 
render the spectrum more ònaturaló in appearance.  In figure 5.31 we see the result of 
applying the operation using the Interpolated Line option and applying noise at a level of 
0.00085 absorbance units. 
 

 
Figure 5.31 Applied Zap  

 
The spectrum is now free of contamination.  Notice that some artifacts have been 
introduced to the baseline, notably the slope on the baseline below 1000cm-1.  We will 
remove these artifacts with the next tool. 
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Manual Baseline Correction 
 
The Manual Baseline Correction Tool is used to remove defects from the baseline of a 
absorbance spectrum.  The associated parameters window and Workspace is shown in figure 
5.32. 
 

 
Figure 5.32 Manual Baseline Correction parameters 
 

The Manual Baseline Correction window comprises two parts.  The first consists of the 
Toolbox Buttons, identical to those of the Zap parameters window detailed in the previous 
section.  The lower part of the window is taken up with a Region Table. 
 
The Regions are chosen such that the Region Markers fall on points of the spectrum that 
we wish to set to zero.  Assuming that the baseline between the Region Markers is flat (i.e. 
has constant gradient) then the entire baseline should be set to zero.  In practice, some 




























































































